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Introduction
Computer Whiz books 1-8 is a diligent attempt to provide the necessary knowledge, 
skills, and attitudes compatible with modern developments in computers and 
technology.

This guide is a collaborative effort, drawing insights from educational experts and 
the latest pedagogical approaches.  It also maps the Computer Whiz primary series 
on Howard Gardner’s theory of 'Multiple Intelligences'. Awareness of multiple 
intelligences promotes an inclusive classroom where all students feel valued and 
supported, regardless of their learning style.

Knowing about ‘Multiple Intelligences’ can significantly enhance teaching 
effectiveness by recognising and addressing the diverse ways in which students learn. 
Recognising and valuing different types of intelligence helps students feel appreciated 
for their unique abilities. This can boost their confidence and motivation to learn.

The content in each chapter is supported by

  Interactive Class Activities4

Fosters an interactive classroom environment 
with our specially designed activities which 
are integrated into the curriculum.

 Class Activity

 Vocabulary Cloud1

Explains essential 
terminology used in the 
chapter.

 Vocabulary  
Cloud

 Lesson Plans2

Step-by-step and interactive lesson plans that cater to diverse pupil needs
(Depending on available time, resources, and pupils' understanding, the 
ideas from these lesson plans can be redistributed among lessons. It is 
recommended to organise the class in such a manner that pupils get some 
practice time at the end of the class.)

 Lesson Plan

  Suggested Answers to End-of-Chapter Questions7

Potential responses to end-of-chapter questions, ensuring a well-rounded 
educational experience for your students.

 Answer Key?

  Homework For Extended Learning6

Suggested homework at the end of each lesson plan 
to reinforce the concepts.

  Homework

 Concept Cloud3

Delves into additional/
optional information and 
intriguing analogies to 
deepen understanding.

 Concept  
Cloud

 Digital Resources5

Lesson wise mapped digital resources provided on the Oxford University Website to enrich 
students' learning experience. These resources are accessible via QR codes at the back of the 
book.

Digital Resources
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Multiple Intelligences
Multiple Intelligences is a theory proposed by Howard Gardner in 1983, which suggests that 
intelligence is not a single, fixed attribute that can be measured solely by IQ tests. Instead, 
Gardner identified several distinct types of intelligences that individuals may possess in varying 
degrees. 

The theory of multiple intelligences broadens the understanding of human capabilities and 
emphasises the importance of recognizing and nurturing diverse talents in educational settings. 
By acknowledging that intelligence is multifaceted, educators can create more inclusive and 
effective learning environments that cater to the unique strengths of each student.

Implications for education
Gardner’s theory has significant implications for education. It suggests that teaching methods 
should be diversified to cater to different types of intelligences. Following are the types of 
intelligences:

Spatial Learners might 
engage more with visual aids 

and diagrams.

Linguistic Learners might 
benefit from reading and writing 

activities. 

Interpersonal Learners 
might prefer group work and 

discussions.

Naturalistic Learners might 

enjoy learning through nature-
related activities

Intrapersonal Learners 
might benefit from self-reflective 

tasks.

Logical-mathematical 
Learners might excel with 

problem-solving tasks.

Bodily-kinesthetic 
Learners might thrive in 

hand-on activities.

Musical Learners might 
enjoy learning through songs 

and rhythms.

How to assess multiple intelligence in students?
Assessing multiple intelligences in students involves using a variety of methods to identify 
their strengths and preferences across different types of intelligences. Here are some effective 
strategies:



C
o

m
p

u
te

r 
W

h
iz

 T
e

a
c

h
in

g
 G

u
id

e
-3

vi

1. Observations
• Classroom Activities: Observe how students engage in different activities. Note which tasks 

they excel in and enjoy the most.

• Behavioural Patterns: Pay attention to how students interact with peers, solve problems, and 
express themselves.

2. Surveys and Questionnaires
• Self-Assessment Tools: Use surveys where students can reflect on their own preferences and 

strengths.

• Teacher-Designed Questionnaires: Create questionnaires that ask about students’ interests 
and activities outside of school.

3. Portfolios
• Work Samples: Collect samples of students’ work across various subjects and activities.

• Reflective Journals: Encourage students to keep journals where they reflect on their learning 
experiences and achievements.

4. Performance Tasks
• Projects and Presentations: Assign projects that allow students to demonstrate their skills in 

different areas, such as creating a video, writing a report, or designing a model.

• Hands-On Activities: Use tasks that require physical manipulation, such as building, 
drawing, or conducting experiments.

5. Peer and Self-Evaluations
• Peer Feedback: Have students provide feedback on each other’s work, focusing on different 

intelligences.

• Self-Evaluation: Encourage students to assess their own work and identify areas where they 
feel most competent.

6. Standardised Tests and Inventories
• Multiple Intelligences Inventories: Use standardised tools designed to measure multiple 

intelligences, such as the Multiple Intelligences Developmental Assessment Scales (MIDAS).

How to embed multiple intelligences in the lesson plans of Computer 
Whiz?
To embed multiple intelligences in the teaching and lesson plans of the Computer Whiz, you can 
incorporate various activities and strategies that cater to different types of intelligences. Here are 
some suggestions:

1. Linguistic Intelligence
• Reading and Writing Tasks: Include activities where students read instructions, write 

reflections, or create stories related to computer concepts.

• Discussions and Debates: Encourage students to discuss topics like the ethical use of 
technology or the impact of computers on society.
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2. Logical-Mathematical Intelligence
• Problem-Solving Activities: Integrate exercises that involve coding, debugging, and logical 

reasoning.

• Data Analysis: Use tasks that require students to analyse data, such as creating graphs or 
interpreting computer-generated reports.

3. Spatial Intelligence
• Drawing and Design: Include activities that involve creating digital art using Paint or other 

graphic design software.

• Visualization Tasks: Use diagrams and flow charts to help students understand computer 
processes and networks

4. Bodily-Kinesthetic Intelligence
• Hands-On Activities: Incorporate tasks that require physical interaction with computer 

hardware, such as assembling parts or using input devices.

• Movement-Based Learning:  Use role-playing or physical games to teach concepts like 
network topologies or data flow.

5. Musical Intelligence
• Sound and Music Projects: Include activities where students create or edit audio files, or use 

music software to compose digital music.

• Rhythmic Learning: Use songs or rhythms to help students memorise computer commands 
or sequences.

6. Interpersonal Intelligence
• Group Projects: Encourage collaborative projects where students work together to solve 

problems or create presentations.

• Peer Teaching: Use activities where students teach each other about different computer 
concepts.

7. Intrapersonal Intelligence
• Self-Reflection: Include journal entries or self-assessment tasks where students reflect on 

their learning and set personal goals.

• Independent Projects: Allow students to pursue individual projects that align with their 
interests in technology.

8. Naturalistic Intelligence
• Environmental Context: Use examples of how technology is used in environmental science 

or agriculture.

• Nature-Inspired Projects: Include activities that involve creating simulations or models 
related to natural phenomena using computer software.
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Chapter 1: Uses of Computers

• Linguistic Intelligence: Writing and sending emails, using browsers to search the Internet.
• Logical-Mathematical Intelligence: Identifying and distinguishing between different types of 

touchscreen devices.
• Spatial Intelligence: Drawing favorite apps on a touchscreen.
• Interpersonal Intelligence: Understanding the importance of respectful communication via 

email.
• Intrapersonal Intelligence: Reflecting on the use of computers in daily life.

Chapter 2: Computer Networks

• Logical-Mathematical Intelligence: Defining ICT, distinguishing between wired and wireless 
networks, understanding LAN and WAN.

• Spatial Intelligence: Visualizing network connections and the flow of data.
• Interpersonal Intelligence: Discussing the uses of ICT in different environments (school, home, 

public places).
• Intrapersonal Intelligence: Reflecting on the importance of networks in personal and 

professional life.

Chapter 3: Word Processing

• Linguistic Intelligence: Using MS Word to create, format, and edit documents.
• Logical-Mathematical Intelligence: Understanding the functions of different formatting tools.
• Spatial Intelligence: Designing documents with various templates and visual elements.
• Intrapersonal Intelligence: Reflecting on the importance of clear and well-formatted 

documents.

Chapter Wise Mapping of Computer Whiz 3
This is a chapter-wise mapping of the book Computer Whiz 1 to Howard Gardner’s 
Multiple Intelligences, highlighting which activities or content support each type of 
intelligence among children:
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Reflection
Reflection after chapter-wise lesson planning is vital for continuous improvement, better student 
understanding, personal and professional growth, and the creation of more effective and inclusive 
lesson plans. It transforms teaching into a dynamic and responsive practice, ultimately enhancing 
the overall educational experience. Here are some key reasons why reflection is important:
Reflecting on each lesson helps teachers identify what worked well and what didn't. It provides 
valuable insights that can inform future lesson planning. Teachers can build on successful strategies 
and avoid repeating mistakes, leading to more coherent and effective lesson sequences.
Every classroom is diverse, with students having different learning styles and needs. Reflection 
helps teachers adapt their lessons to cater to this diversity, ensuring that all students have the 
opportunity to succeed.
While there are many reflection keys available online, attached here is a template that can be used 
with the Computer Whiz series lesson planning.

Chapter 4: Canva

• Linguistic Intelligence: Creating multimedia presentations with text elements.
• Logical-Mathematical Intelligence: Organizing information logically in presentations.
• Spatial Intelligence: Designing visually appealing posters and presentations using Canva.
• Interpersonal Intelligence: Collaborating on design projects and sharing ideas.
• Intrapersonal Intelligence: Reflecting on the impact of visual communication.

Chapter 5: Algorithms

• Logical-Mathematical Intelligence: Understanding computational thinking, creating 
algorithms, and using flow charts.

• Spatial Intelligence: Visualizing the steps in an algorithm and the flow of information.
• Intrapersonal Intelligence: Reflecting on the importance of logical thinking and 

problem-solving.

Chapter 6: Netiquette for Online Communication

• Linguistic Intelligence: Writing clear and respectful emails, understanding netiquette.
• Interpersonal Intelligence: Communicating respectfully and appropriately online.
• Intrapersonal Intelligence: Reflecting on personal online behavior and privacy.
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Reflection Key for Computer Studies
Chapter: ___________ Date: ___________

Key Competencies Checklist
1. Understanding Basic Concepts

 Can students explain the main concepts covered in this chapter?

 Do they understand the terminology used?

2. Practical Skills
 Are students able to perform the basic tasks and operations taught?

 Can they use the software or tools introduced in this chapter?

3. Problem-Solving
 Can students apply what they’ve learned to solve simple problems?

 Are they able to troubleshoot common issues?

4. Collaboration and Communication
 Do students work well in pairs or groups?

 Are they able to communicate their ideas effectively?

5. Creativity and Innovation
 Have students shown creativity in their projects or assignments?

 Are they able to think of new ways to use the tools and concepts learned?

6. Digital Citizenship
 Do students understand the importance of online safety and etiquette?

 Are they aware of the ethical use of technology?

Teacher’s Notes
1. What went well in this chapter?

 

 

2. What can be improved in the next chapter?

 

 

3. Additional Comments: 
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USES OF COMPUTERS01
After completing this chapter, students should be able to:
1. identify a touchscreen,

2. distinguish between a smart phone and a smart TV,

3. write and send an email,

4. attach pictures to the email,

5. use browsers to search the Internet.

Lesson plan 1
Resources
	9 Textbook pages 1–3

	9 Images of touchscreens, smartphones, tablets and laptops being used in different 
environments on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
Ask your students:

	9 What happens when you tap the screen with your finger?

	9 Can you open an app by tapping on it?

	9 How is a touchscreen different from a regular screen?

	9 What can a smart device do that regular devices can't?

Reading and explanation (25 min)
Read pages 1–3

Explain that a touchscreen is a display device that allows users to interact with a computer or 
other electronic devices using their fingers or a stylus. Touchscreens perform the functions 
of both  input and output devices. Some examples of touchscreen devices are smartphones, 
computers, laptops, tablets, smart TVs, ATMs, etc. Speak about the importance of the use of 
touchscreens, tablets and smart devices that enable the students to stay connected through 
texting, calls, video chats, and social media.

Teach students the use of the tap, swipe and pinch movements on smart devices:

Tap is the most used action on a touchscreen device. It involves lightly touching the screen with a 
single finger and lifting it right away.

To tap,

• Use your index or any other finger to touch the screen gently.

• Quickly release the finger from the screen.

Swipe involves moving your finger across the screen in one direction (up, down, left, right) to 
navigate or scroll through pages, images, or switch between screens.
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• Place your finger lightly on the screen.

• Move your finger in the desired direction (up, down, left, or right).

• Swipe with one finger or multiple fingers depending on the device.

Pinch involves using two fingers, usually the thumb and index finger, to either bring the text 
or image closer together or move them apart, to zoom in or out, resize elements, or navigate 
images/maps.

To Pinch,

• Place two fingers on the screen and move them apart to zoom in.

• To zoom out, place two fingers on the screen and move them toward each other.

Discuss the features of touchscreens:

Touchscreens allow you to type and send messages quickly, to interact and play games, watch 
videos, or listen to music with just a tap or a swipe. They make online shopping easy, allowing 
you to browse and buy. They facilitate banking services, making it simpler for you to manage 
your finances. Touchscreen devices allow you to work from home, attend online classes, or 
participate in virtual meetings. They enable voice command, magnification, and speech-to-text, 
facilitating user interaction with technology.
List the uses of smart devices for your students:
They are used to share photos, videos, and update others on social media platforms. They consist 
of apps and games that make learning fun and interactive. They use them to create art. They 
control home appliances such as lights, thermostats, and security systems. Smartwatches and 
fitness trackers help monitor health, exercise and heart rate. Tablets and smartphones allow 
you to check emails, manage calendars, set reminders, and access documents. They can access 
e-books, online articles, and educational videos. They have GPS which helps find directions and 
explore new places using apps like Google Maps. They also allow you to book flights, hotels, and 
other travel services.

 WORD WHIZ 

Interact Act in such a way as to have an effect on each other

Stylus A pen-like tool used to interact with touchscreens on computer 
devices

Zoom in To make an image or window larger to see more details or read text 
more easily

WHIZ TASKS

1. Where are touchscreens used? What are they used for?

  Touchscreens are used in devices such as smartphones, tablets, computers, ATMs, 
medical equipment, and vehicles. They are used to interact with software, navigate 
menus, input data, and control various tasks
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Conclusion (5 min)
Ask:

	9 How does a device with a touchscreen differ from one with buttons?

Homework assignment
	9 The children are instructed to complete Whiz Tasks (Pg 3) at home.

How to Use a Touchscreen Phone or Smart Device:

Touchscreen phones and smart devices enable you to play games, talk to friends, and learn 
new things by simply tapping on the screen.

To turn the device on, press and hold the power button (usually on the side or top of the 
phone or tablet) until you see the screen light up.

Enter a password, use your fingerprint, or draw a pattern to unlock the device.

Icons on the home screen represent different apps such as games, photos, messages. Tap on 
the icon to open the app.

To make things bigger or smaller on the screen,

Pinch your fingers together to zoom out so the picture gets smaller

Spread your fingers apart to zoom in or make the picture bigger tap each key on the 
keyboard to type letters or numbers.

To take a screenshot, press and hold the power button and the volume down button at the 
same time.

To make a call, open the Phone app, tap the numbers, and tap the green call button.

To turn the device off, press and hold the power button until the option to turn off the device 
appears. Tap on it.

CONCEPT CLOUD

Play a game with your students. Have pictures of different apps and smart devices. Distribute 
the pictures amongst your students so each person receives an image. Ask them to explore 
the features of the app or device. On the board, write the name of the device or app as each 
student stands up, shows the picture s/he has and identifies it.

Alternately, you can play a matching game where there are half the number of devices and 
apps as there are students and the characteristics listed on different slips. When a person 
stands up and calls out the name of the device/app, the student who has the matching 
characteristics identifies it.

CLASS ACTIVITY

Lesson plan 2
Resources
	9 Textbook pages 4–7
	9 Images of the Internet being used in different environments on the softboard or a tablet or 

multimedia if available.
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Starter activity (5 min)
Ask your students:
	9 Do you use the Internet to search for something? What do you search for?
	9 What can you do on the Internet?

Reading and explanation (20 min)
Read pages 4–6.
Divide students into pairs and ask them to discuss what the Internet is in a simple way: The 
Internet is like a huge spider web connecting computers all over the world. It helps people share 
information, communicate, watch videos, play games, and learn new things.
Start a brainstorming session. Draw a large web on the board and ask the students to shout out 
ideas about what they can do on the Internet. Write their answers on the board.
Break down the uses of the Internet into categories:
Artificial Intelligence, Education, Online Shopping, Health and Entertainment.
Other possible answers the students may suggest could be Learning, Communication, 
Exploration.
Demonstrate to the students how to search for something online. Show them how to use a search 
engine such as Google to look up some facts such as “the largest water park in the world”. Ask 
them what other information they would like to search for. This helps them understand the 
significance of the Internet as a tool for finding information.
Teach them how to find information using a browser. They should:

• Use simple, clear words when searching.
• Pick the keyword and search as this helps narrow down search results.
• Stick to trusted websites that are safe and educational.
• If they are looking for something specific, they should add details to their search. If they are 

searching for a specific phrase, they should use quotation marks around the words to ensure 
that the search engine looks for those exact words.

Give them examples when teaching.

Explain to your students the importance of staying safe on the Internet. Ask the students what 
rules they would like to adopt for safe Internet use.
Give them the following instructions:
• Never share your full name, address, or phone number with strangers.
• Tell an adult, your parents or your teacher if something online makes you uncomfortable.
• Be kind and respectful when chatting online.

 WORD WHIZ 

Case-sensitive That which differentiates between capital and lower case letters

E-learning Learning conducted via electronic media, typically on the Internet

Influencers People who affect or change the way that other people behave

Interactive Allowing a two-way flow of information between a computer and a 
computer-user

Online libraries A collection of digital content that can be accessed online
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WHIZ TASKS

Think of keywords that will help you find information about educational institutions in 
Pakistan. Write the words in the search bar. 

Educational institutions in Pakistan; Schools in Pakistan; Top universities in Pakistan; Best 
colleges in Pakistan; Private schools in Pakistan

Conclusion (10 min)
Ask:

	9 How does the Internet help you to learn new things?
	9 Why is it important to be careful about what you share online?

Homework assignment
	9 Design a poster that shows Internet safety tips. This could include drawings of people using 

the Internet responsibly, with safety rules.

Lesson plan 3
Resources
	9 Textbook pages 7–10
	9 Images of an email with its formatting on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
Ask your students:

	9 How has communication changed in recent years opposed to when your grandparents were 
in school?
	9 Have you ever sent an email?
	9 What kind of content can you send in an email?

Reading and explanation (20 min)
Read pages 7–10

Emails are used to communicate with friends, family, and colleagues. Students must learn how to 
write emails with attachments including photos. They are taught the benefits of emails including 
convenience, speed, accessibility and ease of communication across distances and email 
etiquette, such as how to write to a person clearly and politely.
Explain to them that email addresses are usually written in small letters. Show them the different 
parts of an email:

• Every email starts with an email address. For example: whiz@oup.com
• The subject line is a short sentence that tells the person what your email is about such as 

Computer Homework.
• Begin your email with a greeting such as Good Morning.
• The main part of your email is the body that contains the message you want to share.
• At the end, sign your name.
• If you need to send a picture, a document or a file, you can attach it to the email.
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Demonstrate how you can send an attachment.

Email folders help you organise your emails and keep things in order. Email folders comprise of:

Inbox is where all the new emails are received. When someone sends an email, it goes straight 
to your inbox. The inbox helps you see all the emails you have received. It is the first place you 
check when you want to see if you have new messages.

Draft folder consists of ideas or the beginning of an email which you haven’t completed. You can 
save it as a draft and finish it later.

The Junk folder is for emails you don’t want such as spam or unwanted advertisements. This 
keeps your inbox free from clutter.

The Sent folder is a record of the emails you send to someone.

The Archive Folder consists of emails you don't want to delete but need to hold onto in case you 
need them in the future.

WHIZ TASKS

Write any two main differences between letters and emails in the table below.

Letters Emails

These are sent through postal mail. These are sent electronically through 
computers.

It takes time for the letter to reach its 
recipient.

The recipient receives the email instantly.

How to Write an Email

Open the email app on your device such as Gmail, Yahoo, or Hotmail. 

Click on Compose or New Email to open a blank email. 

To column, write the email address of the person you are sending the email to. For example, 
computerwhiz@gmail.com.

Write the subject. It represents the heading of your email and states what your email is about. 
Write an email message, using clear sentences.

Before you click 'Send' check if you spelt the name right and if your message is clear and 
kind. Click the 'Send' button.

When writing emails, keep these things in mind:

Always be respectful.

Spelling and grammar must be correct.

CONCEPT CLOUD
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Do not share personal information such as your home address, phone number, or passwords.

Double-check the email address to make sure you are sending it to the right person.

Don’t open emails from people you don’t know. Don’t click on any strange links or 
attachments.

Don’t Use ALL CAPS as it is considered extremely impolite.

Keep your email short and to the point, so the person reading it understands quickly.

Learning to Write Emails
Revise with the students as to what an email is and why it is useful: An email is an 
electronic message you send through the Internet to talk to someone. Emails are a way of 
communicating with others, whether it is for school, work or to interact with friends.

Explain the basic parts of an email:

• Email Address
• Subject Line or title of the email
• Greeting
• Body comprising the main part of the email
• Sign your name at the end of the email so the person knows who it’s from.

Stress the importance of the separate folders that emails are organised into:

• Inbox: where you receive new emails.
• Sent: where the emails you have sent are saved.
• Draft: where you store unfinished emails
• Junk: where you store spam or unwanted emails.

Use one of the computers to demonstrate to the students how to:

• Open an email
• Compose a new email
• Type the recipient’s email address
• Type a subject line that tells the reader what the email is about
• Add a greeting
• Write the main content
• Close the email with a signature

Give students the task of writing emails. Ask them to pair up with a classmate at the 
computer and write the emails together. Alternatively, they can take turns writing and save 
as a draft and then their friend can complete the email. They can write an email asking 
their friend about their favourite book or to thank someone for a birthday gift or choose a 
different reason to send an  email.

CLASS ACTIVITY
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1. Video–Terms of internet

2. Worksheet–Uses and terms of Internet

DIGITAL RESOURCES

Conclusion (10 min)
Ask:

	9 Why is it important to use a subject line when writing an email?
	9 What is the significance of folders?

Homework assignment
	9 Whiz tasks on page 9: Write an email to your friend and tell him/her about an interesting 

landmark in Pakistan that you want to visit during your school holidays.
To:
Subject:
Body:

Suggested answers to end-of-chapter Workstation (page 11)
Explore with Whiz

Fill in the blanks
1. Computer
2. Fingers
3. Global 
4. Electronic 
5. Wireless

Whiz Quiz
1. Touchscreens are used to interact with computer devices.
2. The Internet is a global network of computers that allows them to share information.
3. It is important to have the correct email address to make sure that messages are sent to the 

correct person.
4. Both a smart TV and a smartphone have Internet access and can be used to browse the web.
5. An inbox is a folder in an email system where incoming messages are stored.

Worksheet
Encourage the students to come up with their own keywords by looking at the question. Have 
them type these keywords in the search engine and extract information from the displayed 
results. Let them experiment with different keywords to ensure most elaborate results.

Suggested answers are given below:

1. Do dolphins live in freshwater?

• Keywords: dolphins, live, freshwater
• Fact: Most dolphins live in saltwater, but some species can live in freshwater.
• Answer: No, most dolphins live in saltwater.
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2. Can a kangaroo jump backward?

• Keywords: kangaroo, jump, backward

• Fact: Kangaroos cannot jump backward.

• Answer: No

3. Is the sun a star?

• Keywords: sun, star

• Fact: The sun is a star.

• Answer: Yes

4. Do penguins live in the Arctic?

• Keywords: penguins, live, Arctic

• Fact: Penguins live in the Southern Hemisphere, not in the Arctic.

• Answer: No

5. Does an octopus have three hearts?

• Keywords: octopus, three hearts

• Fact: An octopus has three hearts.

• Answer: Yes

6. Is a whale a fish?

• Keywords: whale, fish

• Fact: A whale is a mammal, not a fish.

• Answer: No

7. Do bees make honey?

• Keywords: bees, make, honey

• Fact: Bees make honey.

• Answer: Yes

8. Can an ostrich fly?

• Keywords: ostrich, fly

• Fact: Ostriches cannot fly.

• Answer: No
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COMPUTER NETWORKS02
After completing this chapter, students should be able to:
1. define what ICT consists of,

2. distinguish between wired and wireless networks,

3. define Wi-Fi and Bluetooth with their uses,

4. distinguish between LAN and WAN.

Lesson plan 1
Resources
	9 Textbook pages 14–16
	9 Image of a computer network on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
Ask your students:

Ask your students and elicit answers from them for the following.

	9 How do you talk to your friends and family when they are far away?
	9 What happens when you send a picture or message to someone on your phone?
	9 What enables three friends in the computer lab to communicate with one another?

Reading and explanation (20 min)
Read pages 14–16.
Ask the children what a network is. Explain that similar to a network that comprises a group of 
friends talking to each other, a computer network is the way computers share pictures, videos, 
and messages with each other.
Draw simple diagrams that represent networks. Draw pictures of computers, phones, or tablets 
connected by lines to show how devices are linked.

Explain that a router is a controller that tells the data where to go. 

Explain that ICT which stands for Information and Communication Technology comprises all 
the tools and devices that help them share information, learn new things, and stay connected 
with each other.

Examples of ICT

Computers
Tablets and Smartphones
The Internet
Emails
Wi-Fi
Digital Cameras
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Social Media apps such as Facebook, Instagram, or TikTok 

Video Conferencing with Zoom or Skype

Interactive whiteboards or smartboards in classrooms

Discuss how wired and wireless networking enable computer devices to connect to the Internet 
and communicate. A wired network refers to devices connected with cables or wires whereas a 
wireless network represents a connection of devices without using wires. As for example, Wi-Fi 
and Bluetooth.

 WORD WHIZ 

Bluetooth A way for devices like phones, speakers, or headphones to connect 
and share information without using wires

ICT The use of computers, the Internet, and other technological tools that 
enable you to share information and communicate with others

LAN stands for Local 
Area Network

A network that connects computers and devices in a small area, such 
as a school or home

Peripheral Devices Devices connected to a computer such as a mouse, keyboard, printer, 
or speakers

WAN stands for 
Wide Area Network

A large network that connects computers over long distances

Wi-Fi Using signals from a router to connect to the Internet without the 
need for cables or wires

Wired Network A network where devices are connected through actual wires

Wireless Network A network where devices connect to the Internet or each other 
through Wi-Fi or Bluetooth

Conclusion (5 min)
Ask:

	9 Can you explain how a computer helps send information to another computer?

	9 What ways may a network help you in school? (Here you can explain to your students that 
computer networks allow them to share files and collaborate on projects.)

Homework assignment
	9 Write a short essay explaining why it is important for computers to be connected to each 

other.

Lesson plan 2
Resources
	9 Textbook pg 17 - pg 19

	9 Image of a computer network on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
	9 Revise the concepts of wired and wireless networks.
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Ask: your students

	9 How does a phone connect to the Internet?
	9 What happens when you connect to the Internet without a wire?

Reading and explanation (25 min)
Read pages 17–19
Discuss the uses of Wi-Fi in different places. How it is important not to do money transactions 
on public Wi-Fi due to the fear of hacking. Explain the different types of networks. Explain that 
the Internet is the biggest WAN.

Get the class to mimic a computer network. Ask each student to pretend to be a computer 
device. Give them a label sticker so they can write down what computer device they are and 
stick it on their shirt. Have them write a message or find a picture to pass on to their friend. 
Then have them form circles of 4 or 5 children. This will represent a network. They can pass 
the messages they have written on to the next person in the circle. Indicate to your students 
that this is how data flows in a network.

CLASS ACTIVITY

Computer networks refer to a group of interconnected devices that can communicate and 
share information with each other.

The different types of computer networks are:

• Local Area Network (LAN): A network that covers a small geographic area such as a 
home, office, or building.

• Wide Area Network (WAN): A network that spans a large geographic area, often linking 
multiple LANs across cities, countries, or continents.

• Metropolitan Area Network (MAN): A network that covers a larger geographic area than 
a LAN but is typically smaller than a WAN, often covering a city.

• Wireless Local Area Network (WLAN): A LAN that uses wireless technology like Wi-Fi 
to connect devices.

Computer networks are used to enable:

• file sharing of documents, images, and other files over a network

• communication by email, instant messaging, video conferencing

• remote access to systems, applications, and files

• users to access websites and web applications.

CONCEPT CLOUD

1. Video–Types of networks

2. Video–Types of Networks: LAN and WAN

DIGITAL RESOURCES
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Conclusion (5 min)
Ask:

	9 What happens if the message does not reach your friend? What can we do to fix it?

Homework assignment
	9 The children are instructed to complete the exercises on the Workstation (Page 20) at home.

WHIZ TASKS

1. a. Monitor, keyboard, and mouse

b. Stylus

c. Smart watch

d. Smart Phone and projector

2. What kind of computer network does your school have?

If the school has a local network the answer should be LAN. If networking depends on the 
Internet, the answer should be WAN. Ask the students to take help from their lab teacher 
and help them reach this conclusion themselves.

Suggested answers to end-of-chapter Workstation (page 20)
Explore with Whiz

Fill in the blanks
1. Network 

2. Bluetooth 

3. Wireless 

4. Local area network 

5. Peripherals

Whiz Quiz
1. A computer network is made up of two or more computer devices that are connected to 

exchange data or resources with one another.

2. ICT stands for Information and Computer Technology. It includes all the tools and devices 
that help you communicate and share information.

3. Peripheral devices are input and output devices that are linked to a computer and controlled 
by it.

4. Wi-Fi is a commonly used wireless technology.

5. Wired networks use cables to connect devices, whereas wireless networks use radio waves to 
connect devices.
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Worksheet
Match the following descriptions with their appropriate labels and pictures.

A network  
covering a large 

area
WAN

Connects devices 
to the Internet 
without wires

LAN

A network  
covering a small 

area
Bluetooth

Tools and devices 
that help us 

communicate and 
share information

Wi-Fi

Connects devices 
without wires over 

short distances
ICT
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WORD PROCESSING03
After completing this chapter, students should be able to:
1. use MS Word and its templates,

2. distinguish between portrait and landscape orientation,

3. select, copy, cut, and paste text,

4. format text and pages to make them stand out.

Lesson plan 1
Resources
	9 Textbook pages 22–24

	9 Image of a word processing document on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
Ask: your students

	9 Why do people use computers to write? How does it make your task easier?

	9 How can you make your story or report look more interesting?

Reading and explanation (15 min)
Read pages 22–24.

Explain what word processing is and how it helps us write, edit, and share text on a computer.
Show the students the different features of the interface. 

Teach them how to open a new document and an existing document and close the program 
when finished. Explain the concept of templates and Smart Art. Discuss with them how to 
highlight text, copy, cut and paste it. Show them how to change the font type, size, and colour of 
text, how to make text bold, italicized, or underlined. Teach them to align their text left, center 
and right. Show them how to use the spelling and grammar check. Teach them how to print their 
work. Discuss the process of printing and check the print settings. Demonstrate to them how to 
save their work and share documents via email or cloud services.

 WORD WHIZ 

AutoSave Automatically saves your work while you’re typing so you don’t lose it

Footer The bottom of a page where you can add page numbers or the 
document’s title

Font The style of the text

Header The area at the top of a page where you can put information such as 
the title of your document or page numbers
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Print preview Shows what your document will look like when you print it

Unformatted text Regular text with no special style

Conclusion (5 min)
Ask:

	9 How can you move a sentence around in a document?

	9 What tools can you use to check spellings?

	9 What can we do with word processing software?

Homework assignment
	9 The children are instructed to complete Whiz Tasks at home.

WHIZ TASKS

Which template will you choose? Give reasons for your answer.

Instruct your students that when choosing a template, it is important to choose the layout 
and design depending on the kind of project. They should choose a simple template like a 
report or resume for formal assignments and colourful templates such as a newsletter or 
poster for creative projects.

A word processing program allows users to create, edit, format, and organise text in a 
document. The key features comprise:

• Typing letters, numbers, and symbols to create written content

• Moving or duplicating text within the document

• Undoing or redoing changes made to the document

• Formatting font style and size

• Changing colour of the text

• Highlighting text

• Aligning text left, center, right, or justify

• Controlling the amount of space between lines of text

• Indenting paragraphs so the space before a paragraph is adjusted

• Creating lists with numbers and bullet points

• Inserting pictures, clipart, or other images into the document

• Creating and formatting tables so information is organised into rows and columns

• Inserting shapes and text boxes

• Representing data in bar, pie, line, or other chart forms

• Organizing content into sections by using different heading styles

CONCEPT CLOUD
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• Adding page numbers to documents

• Generating a table of contents based on the headings in the document

• Checking spellings and grammatical errors and suggesting improvements

• Thesaurus: provides synonyms and antonyms for selected words to help improve word 
choice

• Collaborating so multiple people can work on the same document at the same time and 
view the changes instantly

• Track Changes made to a document

• Saving Files in different formats

• Printing the document

Computer Lab Activity
Do a small recap/revision on word processing. Demonstrate with a document on the screen and 
point out the key features such as the title bar, toolbar, and blank document space. Go over the 
use of the keyboard and the mouse. Discuss how to use the space bar, backspace, and delete keys. 
Instruct them to press Enter to start a new line.
Have students work in pairs or threes depending on the availability of computers. Have them 
open a blank document on their computer.
Give them a topic to write on: How to Save the Environment.
Tell them to create a heading. Then they can suggest four to six solutions that can help protect 
and save the environment. They can add pictures if they like.
Demonstrate how to select text by clicking and dragging the mouse over the words. Show how to 
make the text bold, italics, or underline using buttons in the toolbar. Ask students to practise by 
selecting their name and changing the font style and size. Have them experiment with changing 
the colour of the text.
Explain why it is important to save documents. Show your students how to save their work by 
clicking on “File” > “Save As”. Have them save their document with their names.
While the students are at work, walk around the room to guide them and check their work. 
Encourage them to change the page layout so it looks attractive.

Lesson plan 2
Resources
	9 Textbook pages 25–29

	9 Image of a word processing document on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
Ask your students:

	9 How can you fix a mistake in a word document?
	9 How could you make a word stand out in a word document?

Reading and explanation (20 min)
Read pages 25–28.
Explain to your students that selecting text is like highlighting words or sentences. You can show 
them how to use the mouse or keyboard to do this.
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When using a mouse, click and hold the left button on the mouse, then drag over the text you 
want to select. When the text turns blue, it means that it has been selected. You can also select 
text by using the keyboard. Press and hold the Shift key and use the arrow keys to select text.
When you edit text, it means you are changing or correcting the words. After selecting text, you 
can delete, replace, or move it. After selecting the text, press the Delete or Backspace key on 
the keyboard to remove the text. When you select the text and start typing new words, it will 
automatically replace the old text. To move text, you can select it, then right-click and choose 
Cut, then go to where you want to place it and right-click to Paste.
Explain that formatting means changing how the text looks. This can include making the text 
bold, italic, changing its colour or its size.
To make the text bold, select the text and click on the "B" button in the toolbar or press  
"Ctrl + B" on the keyboard. To italicize the text, select the text and click on the "I" button or press 
"Ctrl + I" on the keyboard. To underline text, select the text and click on the "U" button or press 
"Ctrl + U" on the keyboard. To change the text colour, select the text, click on the Font Color 
button, (usually a letter "A" with a colour), and choose a colour. To change the font size, select 
the text, and click on the number next to the font name to change the size.
Explain to your students that the header is that part of the document that appears at the top of 
each page. It can include things like their name, the title of the document, or page numbers. The 
footer is the part that appears at the bottom of each page. It can include things like the date or 
page numbers.

WHIZ TASKS

Write a short poem. What alignment would you use? How would you format the text?

Suggested answer: I would align the title of the poem in the center so it stands out as the 
heading. The poem should be left-aligned. To format the text, I would make  the title bold 
in a larger font size.

How to Insert a Header and Footer

To insert a header, go to the Insert tab. Click on Header. A small dropdown menu will reveal 
different styles of headers. Choose a Style. You can select a simple style or just click on Edit 
Header to start with a blank one. Then, you can type your name, document title, or whatever 
you want should appear on the top of every page.
To Insert a Footer, go to the Insert tab and click on Footer to view different styles of footers. 
Select one or click Edit Footer to create a custom footer. Type the text. This could be the date, 
a page number, or anything you want at the bottom of the page. Click on the Close Header 
and Footer button to return to your document.

CONCEPT CLOUD

1. Video–Typing and Formatting in MS Word

2. Video–Onscreen tutorial–Formatting in Google Docs

DIGITAL RESOURCES
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Conclusion (5 min)
Ask:

	9 Why is it important to change the way the text looks?

Homework assignment
	9 For homework, the children are instructed to complete Whiz Tasks (page 29). If you need to 

make a small booklet on the city you live in, how will you format it? Where will you set the 
margins?

What orientation will you choose? Instruct the children to create a booklet and format it as 
answered.

Suggested answers to end-of-chapter Workstation (page 30)
Explore with Whiz
1. Ask the students to open MS Word, identify icons for each function and then do this activity.

a. We would press Control + Z to undo the last action we carried out.
b.  We hold down the Ctrl key and click anywhere in the sentence to select words or text that 

are not next to each other.
c. When we press the Control + Y, we redo the last action we had undone.
d. We press Ctrl + A keys together to select all the text in the document.

Whiz Quiz
1. A word processing program creates, edits, formats, and prints text documents.
2. Print Preview display shows how the document will look when printed.
3. A paragraph is a group of sentences that discuss a single idea.
4. Justified text has straight edges on both the left and right sides, with the words spaced evenly.
5. Portrait orientation is vertical while landscape orientation is horizontal.

Worksheet 
1. Expected answers. 

• Bold. Bear

• Italics. The enchanted garden

• Underline. Friends

• Bold and Underline. A poem by Steely Whiz

2.  Ask the students to try doing this in different ways on MS Word and then enlist two of the 
easiest ways.

Additional Questions

You may ask the students to do the following for extended learning:
1. Change the font size of the entire poem to 16.
2. Center-align the title "The Enchanted Garden".
3. Add a border around the entire poem. Describe how you did it.
4. Insert a picture of a bear below the poem. Describe the steps you took to insert the picture.
5. Add a header to the document with your name and the date. Describe how you added the 

header.
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6. Double-space the entire poem. Explain how you changed the line spacing.
7. Find and replace the word "garden" with "meadow". Explain how you used the Find and 

Replace feature.

Tips:
• To make text bold, highlight the word and press Ctrl + B.

• To make text italic, highlight the word and press Ctrl + I.

• To underline text, highlight the word and press Ctrl + U.

• To change the colour of text, highlight the word, go to the font color option, and select your 
desired colour.

• To change the font of text, highlight the word, go to the font dropdown menu, and select your 
desired font.

• To save your work, click on 'File' and then 'Save As'. Choose a location, type a filename, and 
click 'Save'.

• To change font size, highlight the text, go to the font size dropdown menu, and select your 
desired size.

• To center-align text, highlight the text and press Ctrl + E.

• To add a border, go to the "Design" tab, select "Page Borders," and choose your desired border 
style.

• To insert a picture, go to the "Insert" tab, click "Picture," and choose a picture from your 
computer.

• To add a header, go to the "Insert" tab, click "Header," and type your desired information.

• To double-space text, highlight the text, go to the "Home" tab, click on the "Line and 
Paragraph Spacing" icon, and select "2.0."

• To find and replace text, press Ctrl + H, type the word you want to find, and the word you 
want to replace it with, then click "Replace All."
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CANVA04
After completing this chapter, students should be able to:

1. explain multimedia presentation and identify its basic elements,

2. identify different uses of Canva,

3. create projects using the different features of Canva,

4. create appealing visuals.

Lesson plan 1
Resources
	9 Textbook pages 33–35

	9 Image of a Canva interface on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
Ask your students:

	9 What apps do you use to create cards or posters for school?

	9 How do you think Canva can help develop your ideas?

Reading and explanation (20 min)
Read pages 33–35.
Explain that the Canva app or software has a variety of media elements to create different 
designs:
Text: They can add text with different fonts, sizes, colours, and effects and create titles, subtitles, 
or paragraphs.
Images: They can use photos, illustrations, and graphics from the Canva library in their designs 
or use their own images.
Sounds and Music: Students can add audio notes or background music to videos or 
presentations.
Videos: They can add video clips to their designs from the Canva collection or create their own 
video presentations.
Shapes and Icons: There are multiple shapes and icons you can add to your designs to make it 
more interesting.
Animations: Canva lets animate designs. Students can add movement to text, images, and 
elements to make presentations or videos lively.
Backgrounds: Canva provides many backgrounds that vary from simple colours to patterns and 
images.
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Charts and Graphs: Students can create pie charts, bar graphs, and line graphs to show data. 
Stickers and Illustrations: Canva has a variety of illustrations and stickers to make your designs 
more interesting.

The main elements of the Canva interface are:

Canvas (Design Area)

The Canvas is the area in the center where you add and arrange all your elements such as text, 
images, and shapes. You can drag and drop items directly onto the canvas and can zoom in or 
out to view your design.

Toolbar (on the top)
• Search Bar helps search for templates, photos, icons, and other elements.

• Undo/Redo to undo or redo your actions

• File to access the file menu to save your design, create a new project, or access other options

• Share allows you to share your design with others, send it to a friend, or collaborate on a 
design

Side Panel (on the left)
• Templates for a variety of pre-designed templates for posters, presentations and cards
• Elements for your design such as images, icons, stickers, shapes, and videos
• Text allows you to add text to your design
• Background to add colour, gradient, or image as background for your design.
Bottom Bar shows the size of the design, page numbers, and allows you to zoom in and out of 
the canvas.

Navigation and Resize Buttons help adjust the zoom level and use buttons to move around the 
canvas.

 WORD WHIZ 

Animations A series of images shown in quick succession to create the illusion of 
movement; used in videos, cartoons, or computer graphics

Customisable Something that can be changed or adjusted according to your needs

Extensive Something that is large in size, range, or amount

Multimedia Use of more than one type of media to communicate or entertain

User-friendly Something that is easy to use and understand

1. Video–Canva Interface

2. Video–Making a poster on Canva–1

3. Video–Making a poster on Canva–2

DIGITAL RESOURCES
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Conclusion (5 min)
Ask:

	9 already there on page 18

Homework assignment

Lesson plan 2
Ask the students to open Canva at home and explore the interface further.

Resources
	9 Textbook pages 36–39
	9 Image of Canva on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
What is the first step to creating  a poster on Canva?

Reading and explanation (20 min)
Read pages 36–39.

Teach the children how to make a poster on Canva.

Tell them to go to the Canva website (www.canva.com).

Log in to the school account or the free account.

Choose a Poster Template

Click on the search bar at the top and type poster to view poster templates.

Pick one you like or choose a blank poster.

Select a Size for Your Poster

If you choose a blank template, there will be a set size, but you can change it later if needed.

Pick a Background

You can choose a colour or a pattern for your poster.

Add Text to Your Poster

Click on the Text button (the " T " icon on the left).

Choose from heading, subheading, or body text.

Click on Add a heading.

Change the size by clicking the text box and dragging the corners to make it bigger or smaller.

You can also change the font style and colour.

Click on Elements (the star icon on the left).

Search for pictures, shapes, or icons that fit in your poster idea.

Click on the images you like to add them to your poster. You can resize them or move them

around on your poster.

If something is in the wrong place, click and drag it to move it to a different spot.

You can use the arrows to make the text or pictures bigger or smaller.

When you’re happy with your poster, click the Download button.

Choose PNG or PDF to save it. You can also print it out.
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Conclusion (5 min)
Ask students:

	9 What was challenging about using Canva for the first time?

	9 How did you decide on your layout and design elements?

Homework assignment: 
	9 Do the exercises on the Workstation.

Suggested answers to end-of-chapter Workstation (page 40)
Explore with Whiz
1. List the different types of templates on Canva. Ask the students to look at the Canva interface 

online and identify and enlist different templates 

2. Ask the students open Canva, identify icons for each function and then do this activity.

Whiz Quiz
1. Canva is used to create a variety of designs such as cards, posters, flyers and presentations.

2. We can customize the canvas size by clicking on Resize in the top menu, where we can enter 
specific dimensions or choose from set options.

3. The rainbow square is the color palette or color picker used to select or change the colours of 
your design elements.

4. Students benefit from Canva by being creative, developing design skills and creating 
professionally pleasing projects.

5. Templates save time, provide inspiration for design, and ensure that the project has a 
professional appearance.

Whiz through Lab
Students must learn how to navigate the Canva interface and use different design elements to 
create a poster on REDUCE, REUSE, RECYCLE.

Remind the students that Canva is an online graphic design tool that helps users create flyers, 
posters, social media posts, and presentations.

Show them how to log in or sign up for Canva. Revise the main parts of the Canva interface:

• Templates: pre-designed layouts

• Elements: graphics, photos, icons, shapes, and lines

• Text Tools: fonts, styles, and text formatting

• Uploads: images or logos

• Backgrounds: change background colour or pattern

• Download/Share: to save and share designs

Briefly discuss how to create visual appeal with design. Text and images must be arranged and 
aligned to create an organised design. The use of contrasting colours and fonts lends to clarity 
and visual appeal. Balance in the design can be achieved by distributing the design elements 
evenly on the page.



C
o

m
p

u
te

r 
W

h
iz

 T
e

a
c

h
in

g
 G

u
id

e
-3

25

Divide the class into groups of 2 or 3 depending on the number of computers available. Students 
will start by choosing a poster template in Canva. Ask students to design the poster based on 
colours, images, and fonts that match the theme.

Instruct them to add text. Teach them how to change the font size, style, and colour, to use 
different fonts for headings and body text so it stands out and to align text using the alignment 
tools to have a balanced design.

Have them choose an appropriate background that is pre-made or uses a solid colour. Discuss 
how background choice helps make text readable.

Teach them how to adjust image sizes, rotate images, and place text in front of or behind images.

Show them how to use Canva’s alignment tools to position their text and images so the poster 
doesn’t look too crowded. Once students have finished their posters, instruct them to save and 
download their work as a PDF or PNG file.

Worksheet
Make copies of the attached storyboarding worksheet and share with your students to work on 
individually.
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Storyboarding Worksheet Name: ____________________________

Title Introduction

Fruits and Vegetables Whole Grains

Protein Dairy

Now try to recreate this presentation on Canva.
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ALGORITHMS05
After completing this chapter, students should be able to:

1. explain computational thinking,

2. to collect and analyse data,

3. identify patterns and similarities,

4. make predictions based on findings,

5. define algorithms,

6. write clear step by step algorithms in proper sequence,

7. define and use flow charts,

8. make decisions using algorithms.

Lesson plan 1
Resources
	9 Textbook pages 42–45
	9 Image of a page showing step by step instructions to carry out a task on the softboard or a 

tablet or multimedia if available.

Starter activity (5 min)
Ask your students:
	9 What instructions will you give to someone who needs to brush their teeth?
	9 How will these instructions help them?

Reading and explanation (15 min)

Computational thinking helps us break down problems into smaller, easier steps. Computers, 
robots, and even video games follow rules to work. Without step-by-step instructions, they 
wouldn’t know what to do. Computational thinking helps you decide how to get from one 
place to another or how to carry out a project, using multiple steps.

An algorithm is like a list of steps that tell you how to do something. It’s important because 
if you miss a step, you might not get the result you want. Sometimes, big problems become 
easier if you break them down into smaller steps. They are used to make everything from 
video games to websites work. Understanding them helps you understand how technology 
works.

CONCEPT CLOUD

Read pages 42–45.

Explain the importance of breaking down everyday problems into steps.
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Discuss how computational thinking is broken into the following components:

• Decomposition:
  Help students understand how to break big tasks into smaller, manageable steps. What are the 

steps involved?
• Pattern Recognition:
 Ask them to identify repeating themes or patterns.
 Can you spot any repeating patterns in this sequence: 5, 10, 15, 20, 25?
 Teach them to sort objects by colour or size.
• Abstraction:
 Teach them to remove unnecessary details.
 Stress and focus on the important points.
• Algorithmic Thinking:
 Encourage them to create simple instructions.
 Explain how to do a certain task in four steps.
  Explain to the children that data is information we gather about things around us. It could 

be anything that we count, measure, or observe. Instruct the students how to collect data 
and then show them how to organise it into a table. Now, count how many times each object 
appears.

  This helps students learn how to organise data and find patterns. Once the data is organised, 
teach the children what questions to ask about the data they have collected. Introduce a 
simple bar graph to show the data visually. Bar graphs make it easier to understand and 
compare data. You can help students draw conclusions from the data they have collected.

 WORD WHIZ 

Algorithms Step-by-step instructions to solve a problem or complete a task.

Barcode A pattern of lines or squares that keeps information of product.

Chrysalis
Hard outer shell where a caterpillar changes into a butterfly.

Computational thinking: breaking down problems into smaller parts 
to solve them in a logical way.

Emerge To appear after being hidden.

Hatches When an egg breaks open and a baby emerges.

Pictogram A picture or symbol used to represent an idea or object.

Sequencing Putting things in the correct order.

WHIZ TASKS

1. These are the cars that were sold by the car dealer this month.

 Which colour of cars sold the most? RED

 What more can you conclude based on this data?
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a. The green buses sold the least

b. The yellow cars were the second most popular.

c. Blue was the least favourite car sold.

Conclusion (5 min)
Ask:

	9 Why is it important to write down steps from the beginning to the end of a task?

Homework assignment
	9 For homework, the children are instructed to complete Whiz Tasks (Page 45).

	9 Develop step-by-step instructions for getting ready for school.

Lesson plan 2
Resources
	9 Textbook pages 46–49

	9 Image of a recipe with step by step instructions on the softboard or a tablet or multimedia if 
available.

Starter activity (5 min)
Ask your students:

	9 How do you create a sequence of steps to solve a problem or complete a task?

Reading and explanation (20 min)

Flow charts are like pictures of algorithms. They help us see the steps in a problem and 
understand them better. They help you see the entire process, so you don’t miss any 
important steps. They make it easy to explain how to do something to someone else.

Computational thinking, algorithms, and flow charts will teach students to solve problems 
faster. Using flow charts to organise their thoughts and ideas helps solve problems more 
creatively. Understanding algorithms and flow charts will help them understand how 
technology works and teach them how to think logically and explain things clearly. 

CONCEPT CLOUD

Read pages 46–49.

Introducing algorithmic thinking to children is a great way to help them understand the concept 
of creating a sequence of steps to solve a problem. Start by discussing everyday problems that 
they solve. Encourage them to create simple instructions for everyday activities that they are 
familiar with; ask them to think through the steps.

Ask them to describe how to play a game of hopscotch and identify the steps involved.

Create a simple recipe or task. Ask the students to think of the steps needed to complete a task 
or recipe. Introduce the concept of instructions. Ask them to write down the steps and give 
someone clear instructions.
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Tell them to identify different ways to solve a problem. For example, if we had to organise glasses 
in different ways, they could be sorted by size, colour, or shape.

WHIZ TASKS

Write an algorithm to draw Pakistan's flag.

Draw a rectangle.

Colour more than half of the left side of the rectangle green.

In the green area, draw a crescent moon.

Draw a five-point star to the right of the crescent moon, above the crescent.

On the white side of the rectangle, draw a vertical line dividing the green and white parts of 
the flag.

Colour the crescent and the star white to make them stand out against the green 
background.

Conclusion (5 min)
Ask: your students

	9 What do you need to do before moving on to the next step?
	9 What would happen if you skipped a step?

Homework assignment
	9 Write an algorithm for making a chicken sandwich.

Lesson plan 3
Resources
	9 Textbook pages 49–52

	9 Image of a pattern in data on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
Ask:

	9 What are patterns?

	9 How will these patterns help you?

Reading and explanation (25 min)
Read pages 49–52.

Explain that a pattern repeats in a predictable way. It can be a colour, shape, number, or 
sound that happens again and again in the same order. Ask students to identify patterns in the 
classroom or around the school.
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Give students a set of coloured cards or ask them to create them and use them to form their 
own patterns.
Discuss what a flow chart is. Illustrate with a picture or diagram that shows the steps in a 
process. It helps us understand how something works by showing the order of actions. Each 
step is shown with a box, and arrows connect the boxes to show the order of steps.
Flow charts help organise thoughts, solve problems, and explain processes clearly. When you 
want to explain how to achieve a task, a flow chart shows each step in the right order.
Instruct students to think of an everyday task and draw a flow chart for it. This will help 
them see how patterns and flow charts can be used in all sorts of situations.

CLASS ACTIVITY

WHIZ TASKS

1. Oval 2. Represents a decision point 3. Adjust 4. Wait for 2 minutes

1. Video - Computational Thinking

2. Video - What is computational thinking?

3. Worksheet - Writing an Algorithm

DIGITAL RESOURCES

Conclusion (5 min)
Ask:

	9 What shapes or colours will you use to make your own patterns?
	9 What kind of patterns do you see around your home?

Homework assignment
	9 Do the exercises on pages 50 and 52.

Suggested answers to end-of-chapter Workstation (page 53) 
	9 1 and 3 are incorrect. The rest are correct.

Whiz Quiz
1. Computational thinking is the process of solving problems by breaking them down into 

smaller, manageable steps.
2. Tools like bar graphs, pie charts, line graphs, tables, and pictograms help display data in a 

clear and organised way.
3. An algorithm is a set of step-by-step instructions used to solve a problem or complete a task.
4. Algorithms must be in the correct sequence as the steps need to be followed in a specific 

order to achieve the correct result.
5. A flow chart represents the steps in a process, helping to organize and understand the flow of 

actions or decisions.
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Worksheet

No

Yes

Start

Water is wasted due to 
leaking taps

Fix the leak

Check if the 
leak is fixed

End
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NETIQUETTE FOR ONLINE 
COMMUNICATION06

After completing this chapter, students should be able to:

1. follow the rules of conduct for respectful and appropriate communication on the Internet,

2. stay safe on the Internet,

3. understand that privacy is essential on the Internet,

4. write emails keeping the three Cs in mind.

Lesson plan 1
Resources
	9 Textbook pages 55–58

	9 Image of rules of netiquette on the softboard or a tablet or multimedia if available.

Starter activity (5 min)
Ask: your students:

	9 Why should you be careful with your words when sending messages on the Internet?

	9 What should you do if something online makes you uncomfortable?

Reading and explanation (20 min)

It is critical to ensure that online communication is kind and respectful. This helps create a 
positive and safe environment. Staying safe on the Internet helps protect people from online 
scams and from personal information being stolen. It also prevents students from being 
exposed to harmful or inappropriate content. Privacy is essential on the Internet as it is 
absolutely necessary to protect personal information, prevent identity theft, and ensure that 
sensitive data is not shared or misused. It is also important for children to be clear, brief and 
polite when writing emails.

CONCEPT CLOUD

Read pages 55–58.

Explain to the children that they must follow the given rules in online learning:
• Be respectful, use polite language and avoid interrupting others during online discussions.

• Join the online class on time and stay for the entire session.
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• To avoid background noise, mute your microphone when you are not speaking.

• When asking questions or participating in discussions, be clear and precise.

• Stay focused. Don’t be distracted during class.

• If on a video call, make sure your background is respectable and you are dressed properly.

• Don’t share others’ personal information without permission.

• Don’t cheat or plagiarize.

• Technology can sometimes have glitches. Be patient if something goes wrong.

They must show respect on the Internet by:

• using polite language when communicating online.

• listening and responding kindly even if you disagree.

• not sharing other people's personal information or photos without their permission.

• giving them credit for their work.

• not posting mean comments.

• being respectful of their differing opinions, backgrounds, and experiences.

When writing an email, ensure that communication is respectful and clear.
Make sure the email subject is succinct and tells the reader what the email is about.
Begin your email with a respectful greeting.
Be clear about what you are asking or sharing.
Use proper grammar and punctuation.
Be polite and courteous.
Avoid using all capital letters, as it implies that you are shouting.
Keep your language formal, especially if emailing a teacher or someone you don’t know well.
End your email with a polite sign-off message followed by your name.
Before sending an email, make sure it is going to the correct person and that you have attached
any necessary files.
Don’t forward emails to others without the sender's permission.
Be careful about sharing personal or sensitive information.

 WORD WHIZ 

Clear Easy to understand

Courteous Being polite, kind, and respectful to others

Concise Giving information in a few words

Emojis Small pictures or symbols used to express feelings or ideas

Homeschooling Learning at home

Netiquette Rules for proper behaviour when communicating online

Password Secret word or code used to keep online accounts safe

Professional Being serious, respectful and responsible in work situations

Virus Harmful software that can damage or infect computer devices
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1. Video–Three C's of writing an email

2. Worksheet–Netiquette 

3. Worksheet 2–Online Conversation

DIGITAL RESOURCES

Conclusion (5 min)
Ask:
	9 How can you be respectful to others when online?

	9 Why is it important to keep your personal information private?

	9 What will you do if a stranger sends you a message?

Suggested answers to end-of-chapter Workstation (page 59)
Explore with Whiz

Underline the correct answer.
1. Check

2. Professional

3. Formal language

4. Rude

Are these statements true or false?
1. False

2. True

3. False

4. False

5. False

6. True

Whiz Quiz
1. Netiquette refers to the rules for polite and respectful behaviour when communicating online.

2. It is important not to reveal your true identity on the net to protect your privacy and stay safe 
from online threats or scams.

3. The two rules you must keep in mind during homeschooling are to stay focused by avoiding 
distractions and be respectful to your teacher and classmates during online lessons.

4. An example of how an emoji can convey the wrong message is a laughing emoji after a serious 
message which indicates that you may not be taking the message seriously.

5. The three Cs to remember when writing an email are Clear, Concise and Courteous.
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Worksheet
Netiquette Crossword


